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Administering your broker (V7/V8) sHARE

Command line
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Notes: Administering your broker (V7/V8) SHARE

. A broker is a set of execution processes that hosts one or more message flows to route, transform, and enrich in flight messages.

. Administering brokers and associated broker resources includes the tasks that you perform frequently to activate and manage those
resources. Choose the method you prefer to administer your brokers and associated resources.

. Administration of brokers includes the following tasks:
e Managing brokers
e Managing execution groups
¢ Managing message flows
» Developing applications that use the Administration API
e Accessing Administration log information
e Changing the location of the work path
e Managing resources used by brokers
e Backing up resources
e Administering Java applications

. These tasks can be performed by using one, or more, of the administrative techniques supported by WebSphere Message Broker:

. Administer the broker by using the WebSphere Message Broker Explorer, the Broker view in the WebSphere Message Broker Toolkit, or the
product commands. Alternatively, you can write your own programs to use the Message Broker Administration API (also known as the CMP
API).

. Manage the application resources of the broker, which include message flows and message sets, by using the WebSphere Message Broker
Toolkit or WebSphere Message Broker Explorer; these two applications connect to the broker by using a WebSphere MQ server connection,
which is defined to the broker queue manager when you create the broker.

*  The picture on the previous page shows the relationship between the resources that exist at run time, and how they interact with the
WebSphere Message Broker Explorer and WebSphere Message Broker Toolkit.

*  Aswell as administering your broker you also have to consider the external resources that your broker requires and that the message flows
use such as a Queue Manager, File System, Databases and other flow resources.
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Connecting to a broker #q
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* You need to connect to the broker's Queue Manager to perform administration
actions

* MQ Bindings connect to local brokers
* MQ Client connect to local or remote brokers
e Connecting to a local broker
e Just the broker name required
As it's a local broker we can look everything else up
» Graphical tools will automatically show local brokers
e Connecting to a remote broker
* Hostname, port and broker name required
* More advanced options available
SVRCONN channel name if not using the default (SYSTEM.BKR.CONFIG)

The class name and JAR file location of a Java security exit if one is required for the
channel

If using SSL on the channel then the following options are also required:
 Cipher Suite, Distinguished Names, CRL Name List, Key Store, and Trust Store
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Brokers View for Application Developers
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Notes: Message Broker Toolkit sHARE
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. Use the Brokers view to create and work with brokers in the WebSphere® Message Broker Toolkit.

. The brokers view offers a limited set of administration actions and is primarily aimed at developers who want to deploy and test their message
flows.

. By default, the Brokers view is displayed at the bottom of the Broker Application Development perspective in the WebSphere Message Broker
Toolkit. If the Brokers view is not displayed, you can show it by clicking Window > Show View > Other > Broker Runtime > Brokers.

. Brokers that are created on the local system are automatically displayed in the Brokers view. You can add remote brokers to the Brokers view.
When you open or switch to the Brokers view, the WebSphere Message Broker Toolkit attempts to connect to brokers on the local system,
and any remote brokers that have been defined. Warnings and errors might be displayed if the WebSphere Message Broker Toolkit cannot
connect to brokers, for example, if the broker is stopped, or the queue manager listener is not running.

. Right-click the Brokers folder in the Brokers view to display the following options:
*  New Local Broker
* Connect to a Remote Broker

« If you specify a keystore or truststore in the remote connection information, you are prompted to enter a password for the keystore or
truststore when you connect to the remote broker.

* Connect to a Remote Broker Using *.broker File
* Refresh

L
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Message Broker Explorer (MBX)

* Advanced broker management
option designed for administrators

* Plug-in to MQ Explorer

o Extra features

* Create/Manage Configurable
Services

* Performance Views
* Group brokers using broker sets

» Offload WS-Security onto
Datapower

e Administration Log

e Administration Queue

* Activity Log

* Security & Policy Set editors

& MQ Explorer - Eclipse SDK

File Edit MNavigate Search Project Run Window Help
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(%= MQ Explorer - Navigator 52
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&z MBIBROKER
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& Advanced
= Channels
(= Client Connections
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= Services
= Process Definitions
= Namelists

(= Queue Manager Clusters
(= IMS Administered Objects
(== Service Definition Repositories
s Brokers
& MBTBROKER
57, default
A TetMessenger

% Configurable Services
| [ Administration Queue
(22 Broker Archive Files
2 GettingStarted

(& Authentication Information

[Z PageriessageSets.dictionary

InitialMemoryInME

UsedMemorylnMB

CommitiedMemorylnMB

MaxMemorylnME

CumulativeGCTimelnSeconds

") MQ Explorer - Content | E Resource Statistics Graph 53
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5 Properties % . 7 7 B[ B default Resources Statistics (Snapshot time 12:47:02 - 12:47:22) | ¥ MBTBROKER Administration Log &

Property Value Message Source Timestamp Message Detail
i EIP28801  Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmTCPIPServerModesStatsManager/re:
i BIP28801 Change Notification 06-Apr-201112:46:21 EDT The property 'ComlbmTCPIPClientNodesStatsManager/re
i EIP28801 Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmSocketConnectionManager/resourc
i BIP28801  Change Motification 06-Apr-2011 12:46:21 EDT The property 'ComlbmSecurityDirector/resourceStatsRepo
i EIP28801  Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmS0APStatsManager/resourceStatsRe
i EIP28801  Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmParserhManager/resourceStatsRepor
i BIP28801 Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmODBC5tatsManager/resourceStatsh
i BIP28801 Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmJVMManager/resourceStatsReportir
i BIP28801  Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmJDBC ConnectionPoolsStatsManage
i BIP28201  Change Notification 06-Apr-2011 12:46:21 EDT The property 'ComlbmFileStatsManager/resourceStatsRep

-,
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Command line tools

* A wide selection of tools for scripting broker actions
_ _ _ . IBM WebSphere Message Broker 8.0.0.0
* Requires a configured environment & Command Console
« Command console (WindOWS) IBM WebSphere Message Broker Ex
. . . . Java Programming APls
mgqsiprofile (Linux/UNIX) e

JCL or ISPF (z/OS)
* Most commands work against local or remote brokers

BIP1121I: Creates an execution group.

Syntax:
mgsicreateexecutiongroup

\brokerSpec | -e egName [-w timeoutSecs] [-v traceFileName]

Command options:

brokerSpec' is one of:
(a) 'brokerName' : Name of a locally defined broker

(b) '-n brokerFileName' : File containing remote br
(c) -1 ipAddress -p port -g gMgr' : hostname, port
-e egName' name of the new execution group
-w timeoutSecs' maximum number of seconds to wait
'-v traceFileName' send verbose internal trace to t

oker connection parameters (*.broker)
and queue manager of a remote broker

for the execution group to be created
he specified file.
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Notes: Command -line =

* Message Broker ships with commands for performing configuration and administration actions
which complement and extend our graphical administration options

* On distributed platforms you need to apply the mgsiprofile to be able to run the commands

* On z/OS the commands are available as jobs, console commands, or both

* During broker customization you should copy the sample jobs from the SBIPSAMP/SBIPPROC libraries to
the broker’'s component dataset

* The commands run by jobs are run as the user submitting the job
Unless a USER=<user> statement is added to the JCL

» Console commands are run by the broker userid and are run inside the main broker started task address

space
e Two types of commands:

* Java based ones which used to be the commands that talked to the Config Manager
These use the CMP API
Can work with local and remote brokers
Eg: mgsideploy, mgsicreateexecutiongroup, mgsistartmsgflows
You get the full brokerSpec options for connecting

* Older commands which just work with local brokers
Eg: mgsistart, mgsistop, mgsireload, mgsichangeproperties

. LI
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Command -line examples =

* mgqsilist
« Displays a list of local brokers
« Displays detailed information about brokers and their deployed resources via —d option
This works with local and remote brokers

BIP1288I: Message flow 'simpleflow' on execution gr oup 'ello’ is running.
Additional thread instances: 'O’
Deployed: '24/07/09 16:37"' in Bar file 'C:\My Docum ents\BAR Files\test.bar'

Last edited: '08/08/07 17:42'
User-defined property names:

Keywords:
Author = 'Matt'
Information = 'This flow simply removes messages fr om SYSTEM.DEFAULT.LOCAL.QUEUE'
Usage = 'This usage is buried inside the CMF' VERSI ON ='v1.1'

* mgqsistart / mqgsistop
» Use to stop and start brokers

* mgqsireload
« Use to restart a restart a broker, or a single execution group to pickup configuration changes
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Message Broker API (CMP) swaRE

1 CommacSory ¢ Rgiay

« Java interface that enables the broker administration tools
* Use for custom administration requirements
e Fully documented and samples available

=g

e > TIEIR
= cogom e B oo - 6 X &, CMP API Exerciser = =ES
:\ﬂﬁ::::,;om‘ Package [SEY lalized Help. WebSphere Message Broker™
s creoonectstenet. SUNARY NESTED LD | cone™ e e AP
[ ! : MBTEROKER | BrokerProxy Method Result
AdvancedAdminislereqobjecttisienss getBrokeriongVersion() 5000-191002. 1 A~
s HAStatus Class ExecutionGroupProxy ...\pager.bar getBroker0SArch() prrs i
ectonparameters ) F TextMessenger.cmf getBrokerOSName() Microsoft Windows XP =
BrokerProwy L[5| PagerMessageSets. dictionary getBrokerO5Version() 5. 1 buid 2500 Service Pack 3 -
BrokerProxy PolicyType L] WIFT.bar
ComttamacatErane: cepton e e tBrokees Versori) tiool
ConfaanagerProxvLogaedxception [ swift_2002_MT103.dictionary getConfigurationObjectType() <Broker>
ConfiglanagerProsyLoggeaQEXcepion - Administration L E 2
ConfigianagerProxyPropertyNotintializedExcepti | Each a broker can by " 0y getConfigurationCbjectTypeOfParent() (rwally
ContgianagerproxRequesiFallreExceplon :
con mamésew‘(; Tn order to use bjects, first obtain handles to them. Here is an example of how to do this: l_! Administration Queue e tExecutionGroups()
Contiatetype Seokescommactisnparansters hep - (= Configurable Services 5] <default>
Depiojedosiect Srokerrrons b - Seokerbronyserhetance o) | e getHTTPListenerPropertyNames()
Deploymentbescriptor ot 1en)s
DeployResult HTTPConnector/URIEncoding
Bt oncestnparameters i g i iniseredObi HTTPConnector facceptCount
o Respomiis T o s comier ol mengs B Proide e S o delo o e oo o eprerrtd 1y o s HTTPConnector/address
. owDependency Internal Collaborators | ‘com.ibm.broker.config proxy. MessageFlowProxy HTTPConnector/allowTrace
iessageFoupron Userrace HTTPConnector buffersize
MoblopertFlesoeComecionpatameters HTTPConnector fcompressableMimeTypes
Gperationy P— =
zeiﬁe%}dew%war\m‘lzr\zgevpmxi o HTTPConnector/compression
eniceGroupPoxyltem e e HTTPConnector fconnectonlinger ot
SenicePronyiem ‘ ;‘;zh:ﬁ o e oeesiciasd s shers seievens =
aaes Zugmm’;,u . : Successfully registered for updates to the log <Log>. A
iea Sethunsinerzoperty (String, Sering) £5)
Successfully registered for <Administration Queue>.
' eracen v adte o oRoeFIE ) Successfully connected. Click on an object to select it and display its properties.
Right-click a selected object to manipulate it.
The CMP API Exerciser is set to wait for requests to be fully completed by the broker before
e ' FepebsaRezshcrive ) N returning; expect pauses while the broker processes each request.
‘You can change this setting using File -> Set Timeout characteristics.
<---- cmip.exerciser. ClassTesterForBrokerProxy. testConnect ToLocalBroker
-
Connected to broker ‘MB7BROKER'.

New - © V8allows you to create and edit message flows too

in V8 « Build your entire system programmatically!
- SHARE in Atlanta



CMPAPI Example = )
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« This simple example connects to a broker on the local machine and deploys a bar file
and displays the result

import com.ibm.broker.config.proxy.*;
public class DeployBAR {
public static void main(String[] args) {
BrokerConnectionParameters bcp =
new MQBrokerConnectionParameters(‘localhost”, 2414, "MB7OMGR");

try {

BrokerProxy b = BrokerProxy.getinstance(bcp);
while(!b.hasBeenPopulatedByBroker()) {}

ExecutionGroupProxy eg = b.getExecutionGroupByName("default”);
DeployResult dr = eg.deploy("MyBAR .bar", true, 30000);
System.out.printin("Result = "+dr.getCompletionCode());

} catch (Exception e) {
e.printStackTrace();

}
}
}
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CMP API Exerciser s 3

&, CMP APl Exerciser

: i BrokerProxy Method Result
E'_T":':- default getBrokerLongVersion() 500091002, 1 ~
E’[g' ... \pager.bar getBroker0SArch() %86 M
5 TextMessenger. cmf getBroker0SName() Micrasoft Windows XP -
: L5 PagerMessageSets.dictionary getBrokerCSVersion() 5.1 build 2600 Service Pack 3 -
E'[g' - \SWIFT. bar getBrokerVersion() 7000
L2 swift_2002_MT103.dictionary getConfigurationObjectType() <Broker =
F' Administration Log getConfigurationObjectTypeOfParent() {roall}
| | administration Queue getExecubonGroups()
&7 Configurable Services [1] <default>
getHT TPListenerPropertyMames()
HTTPConnector URTEncoding
HTTPConnector facceptCount
HTTPConnectorfaddress
HTTPConnector falowTrace
HTTPConnector fbufferSize
HTTPConnector fcompressableMimeTypes
HTTPConnector fcompression
HTTPConnector fconnectionlinger
Successfully registered for updates to the log <Log=>. A
Successfully registered for <Administration Queue>.
Successfully connected. Click on an object to select it and display its properties.
Right-click a selected object to manipulate it.
The CMP API Exerciser is set to wait for requests to be fully completed by the broker before
returning; expect pauses while the broker processes each request.
You can change this setting using File -> Set Timeout characteristics.
<---—- cmp.exerciser. ClassTesterForBrokerProxy.testConnectTolocalBroker
v

Connected to broker 'MB7BROKER'.




WMB Development Lifecycle and Environments SHARE
« Application Developer « Administrator
- Develops message flows, message * Customizes BAR for target
models etc. environment (message flow
« Unit Tests on local machine properties including queues, database

names etc.)
* Deploys BAR to target broker

« Broker management and operational
control

* Creates Broker Archive (BAR) files
containing required artefacts

Development QA Production
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Common Administrative Tasks

* Planning and configuration
* Bringing a new broker online
e Securing a broker
* Making a broker highly available
* Planning for disaster recovery

o
o
)

8
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%
—
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 Managing brokers
* Managing what'’s deployed
* Understanding broker behaviour
¢ Optimizing and tuning
e Migration
¢ Maintenance

r'n..
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Bringing a new broker online

» Typical steps required
* Preconfiguration (e.g. OS, userids)
 Installation (MQ, MB, additional software)
» Creating the broker
« Creating execution groups
* Deploying BAR files
« Additional configuration (e.g. security, userids)

* Ensure that the environment is reproducible *
* Documentation
» Scripting
 Virtualization

- SHARE in Atlanta
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WMB and the Cloud sHARE
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« Consider virtualization technologies for new environments
* Makes it easy to provision new systems (and restore known state!)
* WMB supports the use of them
» Understand maintenance and performance aspects

WebSphere CloudBurst

P WM B H ype rviso r Ed iti 0 n Welcome Virtual Systems Patterns Catalog
Virtual Images 4

* IBM Workload Deployer appliance e
WebSphere Application Si @ #

=) WebSphere Message
WebSphere Application Si Broker - Advanced
7.0.0.1
WebSphere Message Bro
WebSphere Portal (Beta) @ #
configure deploy SE— # VMB: Create

Execution Group (Basic)

B =
% WMB: Create
Execution Group (Basic)2

B =

% WMB: Deploy Bar Files

WebSphere Process Serv

) ’ ) | I

b4
% WMB: Execute MQSC




Securing a broker suARE

Administrative security in V7/V8 allows 3 levels of authorization:
* Reading
» Writing
« Executing (i.e. starting and stopping)

* On two object types:
* Broker
* Execution Group

* Administrative Security is not enabled by default
» Access controlled using MQ queues on the broker’'s queue manager

» For those migrating from 6.x there is guidance provided for migration from
CM ACLs

* Though there is not a one-to-one mapping

LR
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SYSTEM.BROKER.AUTH

Secu rity QueueS SYSTEM.BROKER.AUTH.<egname>

'L MEZOMGR - SYSTEM.BROKER.AUTH - Manage Authority Records

== Spedfic Profiles

- BB 5vSTEM,BROKER, AUTH

= Generc Profiles 4 Mame Browse | Change | Clear | Delete | Display | Ge Put | Set
B Matt@LUCAS 4 4 ¥ 4 | « v
L Sos s A L ¥

Groups | Users

'Y New Authorities

Entity type: | Lser |
Entity name; | MyBrokerllzer |
Ohject type: | Queue |
Profile name; | SYSTEM,BROKER. AUTH |

|

Queus manager name; | MEFOMGR

Authorities
Admiristration Context MQI +inqg = Read
[ change [1Pass all context [Browse _~ +put = Write
[ ]clear [ |Pass identity context 2 / +set = Execute
[ eelete [ ]set all context Inguire
[ ]oisplay [ ]setidentity context Put

Set

]

mew.. || Edt.. |[ Del

[ Select all J [Deselectall]




eSS .. 22220909292
Required Task Authorizations re

Queue Names
Tasks SYSTEM.BROKER.AUTH | SYSTEM.BROKER.AUTH.EG i
Set broker properties R+W
View broker properties R
Create or delete configurable services R+W
Set configurable services properties R+W
View configurable services properties R
Create or delete execution groups R+W
Rename execution groups R+W
List execution groups R
Start or stop execution groups R X! X1
Set execution group properties R wW
View execution group properties R R
Start or stop resource statistics collection R X
Report resource statistics R R
Deploy R wW
List message flows and other deployed objects R R
Start or stop message flows R X
Delete resources from an execution group R wW

Note: X! Execute access is required on the broker or on an individual execution group

-
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Required Command Authorizations

= )

SHARE
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Queue Names
Command SYSTEM.BROKER.AUTH | SYSTEM.BROKER.AUTH.EG
mgsichangeresourcestats R X
mgsicreateexecutiongroup R+W
mqgsideleteexecutiongroup R+W
mgqsideploy R wW
mgsilist R R?
mqgsimode R (to display)

R+W (to change)

mqsireloadsecurity R wW
mgsireportresourcestats R R
mgqsistartmsgflow R X
mqsistopmsgflow R X

Note: R You require read access on any execution groups for which you wish to display information

.-' ™
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Making the broker highly available SHARE

« How do | ensure that the broker is continually processing messages?
* Active/Active vs. Active/Passive
» Agree SLAs with the business (% uptime)

» The broker includes restart recovery, but this is usually not sufficient on its
own

¢ Two main options
* Third-party solutions (e.g. VCS)

« Multi-instance queue managers and brokers
Run your broker as an MQ service

LR
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Planning for disaster recovery SHARE
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* What would you do if your primary WMB location
goes down?

* Distribute WMB to multiple sites if possible

* This introduces data replication and latency
concerns

» Keep DR concerns separate from HA! /ﬁ\

« HA: Systems at a single site with a single
configuration
DR: Systems at multiple sites with replicated
configurations

* An HA failover can be a planned activity; DR is
unplanned.

.-' ™
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Backing Up

Regularly use mgsibackupbroker to backup the broker’s configuration *
 |deally, after all configuration changes

* Backup an active broker as long as it’s not processing configuration changes

Consider required resources, for example:
« Database tables
» Source artefacts (message flows, BAR files)

Ensure regular restore testing
* Use maqsirestorebroker to restore a broker’s configuration

* Use the backup file that is created to restore a broker in an identical operating
environment

The operating system must be at the same level, and the broker and queue manager
names must be identical.

WMB V7 pattern to reconstitute message flows from a running broker

. LI
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New H_g"
in V8

i hat's deploved suane
Managing what's deploye
'E:E Brokers 4 (2 Brokers 4 &t Brokers
& MBSBROKER 4 & MBSEROKER 4 /2 MBSBROKER
sz default 4 s2 default 4 75 default

= > Bill Payments Processor - [4L Bill Payments Processor
MF_FLMEM_007 g y = e
= s Claims Handler 4 aims Handler
MF_GDRTM_003 MF_GDRTM 006
MF_GDRTM_006 MF_GHRTS_ 102
MF_GHRT5_102 @ Claims Handler
MF HADRM 102 4 B Shared WS Interface
+H MAP_FGG_TO_WOR 4+ MAP_FGG_TO_WOR
+H MAP_WQOR_TO_FGG  MAP_WOR_TO_FGG

It can often be difficult to understand what individual deployed resources are used for

Applications and libraries can allow you to understand precisely why each file is there
* Application: Encapsulates a single use case or scenario
« Library: Promotes re-use of a shared set of files

» Concepts are shared between WMB developers and administrators

 The WMB developer chooses to create an application or library; the collection is then carried all the
way through to the broker runtime

LR
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Managing shared resources swaRe
.

.esql .Subflow

.ms|

Broker

_—

.dfdl

* V8 also allows you to deploy source files directly to the broker runtime
e Subflows (.subflow), ESQL (.esql) ... in addition to CMF etc.

* This means that you can manage subflows and ESQL independently of the message
flows that use them

« Update a shared service once only per execution group

« After deployment of a new version, all affected message flows pick up any changes with
the next message

- SHARE in Atlanta
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Understanding broker behaviour

 The tools include a lot of information that is useful to the
administrator, for example:

* Administration queue and log, Message flow and
resource statistics

« Warnings when features that affect performance are
enabled

MO Explorer - Content | ¥~ MB7EROKER Administration Log &3

=48 Brokers
= q’ﬁ ME7BROKER [running, connected]
= 5_,"?__. default [running]
simpleflow [running]
eL%_. foo [running]
(% Configurable Services
i

{Jﬂ test [stopped]

= O

The property 'ComIbmIyMManager fvmMaxHeapSize' has changed from -1 to '1023356384 on object 'default’ of type E
The resource TextMessenger' of type ‘MessageFlow' was modified on object 'default’ of type ExecutionGroup’ with pare
The property 'object.runstate’ has changed from running’ to 'stopped’ on object TextMessenger' of type MessageFlow
The request made by user Matt' to 'stop’ the resource TextMessenger' of type MessageFlow' on parent 'default’ of typ

Message | Source Timestamp Message Detail
i BIP2as0l Change Motification 09-0ct-2009 10:18:30
i EBIP2s3a Change Motification 09-0ct-2009 10:17:13
i EIP2s30I Change Motification 09-0ct-2009 10:17:13
I BIP23711  Administration Result 09-0ct-2009 10:17: 12
i BIP2371I Admlnlsh’aten Request 09-0ct-2009 10:17:10

The request made I:uy' Lser Mat‘t to step the resource "I'exh'-«"lessenger u:uf t'g.fpe MessageFIe w' on parent default u:uf typ

= @w&e@e&w www ne 16:1;

31-161351) &

R

[cics [ corea|ETeagent [ FTP [ File | JDBCConnectionPools | VM | ODBC | Parsers [ 50APInput | Security | Sackets | TCPIPClientNodes | TCPIPServerodes
narme Threads ApproxMemkE MaxReadKB MaxWrittenkB Fields Reads FailedReads Writes
sUmmany 1 111.78 0.54 043 a3 24 i 16
TextMessengerMQMD 1 1597 0.36 0.43 2 8 0 4
bAeccenmer BAOROIOT 1 55 R0 54 000 25 4 i Fi |

* Use this information to understand recent configuration changes, how the .

broker is performing, connected endpoints, etc.
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Resource Statistics XML =
e
* Based on existing accounting and statistics framework
« Sample XML published to
$SYS/Broker/<broker>/ResourceStatistics/<eg>

“Rescursceitatistics brokerLabel="STREES551"Y brokerUU0ID="1eSe4kbal-020a-4f931-abi7-T42006294eilb™ execuntionGroupNamn
e=Teg FLE . 5CCHEET 1" exermiti nnfzrmplllIT =" 1 5nna 2 F=2407-0000-0080-8AR3NL3R2ZNTE" =2-artNate="2003-10-08" =2rhartTim
e="1C:29:26.198" endDate="20C3-10-08" enclime="10:29:46.270">

()
L
|
13

= name="Sockecz">

dentifier name="sumnary" TctalMessages="534" MinimumMessagesPerMiaute="1_73" HaximonmMessage=FPer

Cre3gur
Lo oU

I
Ld

HMizare="1353" AverajyeMessagesFPerMinurce="I3iZ5" TorLalhGyTedsSent="10665317" MinlmMmMEyTesSS2nTPFersecond="1571" MHaxil
muanBEytcciBentlerScecond—"A17568" AvcrageBytcolfontlerScecnd—"42323341" TotalBytcolcoccived—"22829E58" MinimunEytcallcecl
vedPerS2mnnad="2A22 " MaximimByte=sRernel vedFerSeonnd="174553" AwverageRyv-esBeneivedPrriemand="32547 MinimmRytesS=

ntiferMessage="23262T" MaximunByvoesSentFerMessage="25027" LveragelvyiesientPerMessage="2506221" Minimum2ByoesEe
ceivedParMe=szage="54338" MaximunBviesBeceivzdPerMes=zage="54338" AverageBytesBeceivedPerMez=zage="163014"/ >

eId name="lzcalhost.7800" TotalMessages="441" MinimumMessagesPerMinute="1323" MaximumtMess
agesferdinure="1353" AverageFessagesPerMinuce="1353" TocalbyrtesSent=":314z2" HMiiaimunmSyresSearFerSecond="11571
" HomimumByibcoScntlocrScoond—"11E7LY" AveragoeBytcoBcntlcriceond—"11571" TotalBytcolcociwved—"2253117" MinimamEyvio
sReceivadPerSecond="12455" MaximmnBytesReceivedPeriecond="11455" AverzgebytesReceivedPerSecond="11455" Hinimn
nEytesSzntPerMeszage="502" MaximunEByvtesSentPerMessage="30Z" LAverageByvtesSentPerHeszagye="502" HinimumBytesEecz

ivedFerMezzage="437" MaximomEvt=sReceiveciPerMes=zage="497" LverageBviesReceivedPerMeszage="437"/>
<rezourceldentifier name="localhost.7900" TotalMessages="393" MinimumMessagesPerMinute="1179" MaximimMess
agesFerHdimuTe="1173" AveragekessagesFerHinuce="117%" ToIalBVCEeSSent="535125" HilzinumSyresseacFersecond="41758

" MarmimumByrtesfentPeriecond="41754" NwveragedytesSentFerlfecond="41753" TotcalBytceszsfecelwved="535841" MHinimumBvtes
REeceivedPerSeconc="26%2" MaximunBrtesBeceivzdPerSecond="2632" AverageBvtesReceivedPerSecond=":892" MinimunmSvEt
esiencPerMessage="2125" MaximumBvytesSencFerMessage="2125" AveragebBy-oesSentPerMessage="2125" MininmunBycesRecel

qa S

vedPerMzzzage="1Z2T" HMaximumBEytesBecelvedFerdessage="137" LverageBytesbeceivedPerMessage="13T";>

N T ——

L/ kesourcel ypes

- - LN
LinEgduunl o ld L Lol LS
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Understanding broker behaviour (V8) swame

Tghimipgy + Commuctars | Baisky

F
s &2 Brokers ¥ Administration Log est Activity Log &3
+ & MBSBROKER 7 Refresh | Fiter: cleer || e
a 55 default i |Messgg§ ITrnjga_@ Iw
|! MF—=tot s nns | .'l BIP120011  20-Jun-2011 06:28:07.03...  Connected ta JMS provider "“WebSphere_MQ
MF Ctart 1 BIP120021  20-Jun-2011 06:28:07.06... Created a 'Transaction_Mone' session far IMS provider "WebSphere_MQ
i - 1 BIP120041 20-Jun-2011 06:26:07.17...  Created IMS producer For destination "ACTIVITYLOG_IMS_REC
ME 2 Stﬂp ) BIP12014E  20-Jun-2011 06:28:07.24,..  Failed to send message ko 'ACTIVITYLOG_IMS_REC'
MF .5 Refresh i BIP120041  20-Jun-2011 0A:28:07.17... Created JMS producer for destination 'ACTIVITYLOG_IMS_REC
il €9 BIP12014E  20-Jun-2011 06:26:07.25... Failed to send message ko BCTIVITYLOG_IMS_REC
@ Red 3 Delete l BIP120011  20-Jun-2011 06:28:09.77... Connected to JMS provider "WebSphere_MQ
M - 1 BIP120041  20-Jun-2011 06:28:09.80... Created JMS producer For destination 'ACTIVITYLOG_IMS_REC
§ 'F' GpEﬂ ﬁnCtI‘-"Itj" Ll:lg €3 BIP12014E  20-Jun-2011 06:28:09.81...  Failed to send message ko 'ACTIVITYLOG_JMS_REC'
M4 i1 BIP120041  20-Jun-2011 06:28&:07.20... Created JMS producer For destination 'ACTIVITYLOG_IMS_REC
(% Confic Statistics * ) BIP12014E  20-Jun-2011 06:28:07.24...  Failed to send message ko 'ACTIVITYLOG_IMS_REC'
U Adrir 1 BIP120041  20-Jun-2011 06:28:09.81... Created JMS producer for destination '&CTIVITYLOG_IMS_REC
PSS C I T R S Llzer Trare k FA mrmisaias ms s sedd Asasns an oo oo b R A s e

« The new Activity Log shows you all recent activity on a message flow or
resource manager

* For example, “Show me all recent IMS activity”
* Visible in MBX (through the CMP) and/or written to a file
» Customisable rotation rules (based on age or size) and content

-

- SHARE in Atlanta
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Optimizing and tuning SHARE

* The tools allow you modify the broker’s configuration operationally
* These tweaks more efficient to make than modifying message flows

* Encourage developers to create message flows that enable operational tweaks to
be made, e.g.

« Configurable Services
» User-defined properties
» User-defined configurable services
Support migration of your flows from test & development through QA into production

== Configurable Service

Confi ble Servi . . .
anligtirable service I File Input Node Properties - File Input

Create a new Configurable Service and set its attributes

Remote Transfer

Transfer protocol ’ FTP
*Mame MY _FTP_COMFIGURABLE_SERVICE

Server and port MY _FTP_COMFIGURABLE_SERVICE

*Type ’FtpSerl.rer
&.q. ftp.server.come2 [if port not specified 21 (s assumed for FTP, 22 for 5FTE)

Temnplate ’None

L R P

Key Value

serverMame ftp.example.com

LR
- SHARE in Atlanta
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Notes: Configurable Services £

SHARE
Tntkrmisgy + Commmsars + Saists

Allows separation of flow design from the details about external services
* eg: SMTP server or a JMS provider
* Flow developer configures nodes with the configurable service names

» Broker administrator creates and configures the configurable service with
appropriate values

» Restart the execution group for changes to take effect
» Configure using Message Broker Explorer or using the commands

* mgsicreateconfigurableservice — create a new configurable service
mgqsicreateconfigurableservice <brokerName> -c <cs name> -0 <cs name>
mgsicreateconfigurableservice <brokerName> -c <cs name> -0 <cs hame> -n <property>,<property2> -v

<value>,value2>

* mgqsichangeproperties — change an existing configurable service
mqsichangeproperties <brokerName> -c <cs type> -0 <cs hame> -n <property> -v <value>

* mgsireportproperties — report available configurable services and their attributes
mqsireportproperties <brokerName> -c <cs type> -0 <cs hame> -r

« mgsideleteconfigurableservice — delete a configurable service
mqsideleteconfigurableservice <brokerName> -c <cs name> -0 <cs hame>

K
irn Al =t =
. SHARE in Atlant:
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Configurable Services i = §

SHARE
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 Extensive list available

* Aggregation * JDBCProviders * SecurityProfiles

* CICSConnection * JDEdwardsConnection * Service Registries
* Collector * JMSProviders * SiebelConnection
« CORBA * MonitoringProfiles e SMTP

* EmailServer * PeopleSoftConnection * TCPIPClient

* EISProviders * PolicySets * TCPIPServer

*  FtpServer * PolicySet Bindings * Timer

* [IMSConnect * Resequence » UserDefined

» JavaClassLoader *  SAPConnection

-
M Explorer - Content &3

Configurable Service CICSConnectionTemplate

Properties CuickMigw;

Marme CICSConnectionTemplate
Twpe CICSConneckion
CicsServer

clientApplid

clientQualifier

conneckionTimeoutSecs 30

gatewawURL local:
requestTimeoutSecs 120

securibyIdentity

- SHARE in Atlanta



Notes: Configurable Services - example s )

mgsicreateconfigurableservice MB7BROKER -c JDBCProviders -o DB2EXTRA -n connectionUrlFormat
-v "jdbc:db2://[serverName]:[portNumber]/[databaseName].user=[user];password=[password];"

mgsichangeproperties MB7BROKER -c JDBCProviders -0 DB2EXTRA -n maxConnectionPoolSize -v 20

mgsireportproperties MB7BROKER -c JDBCProviders -0 DB2EXTRA —r

JDBCProviders
DB2EXTRA

connectionUrlFormat="jdbc:db2://[serverName]:[portNumber]/[databaseName]:user=[user];password=[password];'
connectionUrlFormatAttr1="
connectionUrlFormatAttr2="
connectionUrlFormatAttr3="
connectionUrlFormatAttr4="
connectionUrlFormatAttr5="
databaseName='default_Database Name'
databaseType='default_Database Type'
databaseVersion='default_Database_Version'
description="default_Description’
environmentParms='default_none'
jarsURL='default_Path'
maxConnectionPoolSize=20'
portNumber="default_Port Number'
securityldentity="default_User@default_Server'
serverName='default_Database Server_Name'
typedDatasourceClassName='default_Type_ Four_Datasource_Class_Name'
typedDriverClassName='default_Type_Four_Driver_Class_Name'

BIP8071l: Successful command completion.

mgsideleteconfigurableservice MB7BROKER -c JDBCProviders -o DB2ZEXTRA "b'!'l.n.HARE in Atlanta
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Migrating between versions 1/2 swaRe

o ¢ Buis

» Message Broker supports same-machine coexistence of different versions
 Install new version alongside your previous version
* However, must use V7+ tools for v7+ brokers, v6.x tools for v6.x brokers/ConfigMgrs
* Single command to migrate brokers between versions (forwards and backwards)
* Migrate directly to V7 from V6.0 or V6.1; to V8 from V6.1 or V7
* Use the same MB Toolkit version as the target runtime (e.g. V7 toolkit for V7 flows)

» Migration Process (to V7 or V8)
e Ensure you're at MQ V7.0.1.x

* If you're using V6.x MB pub/sub, migrate subscriptions to MQ pub/sub using
migmbbrk

* Migrate brokers using mqgsimigratecomponents, or create and deploy new brokers
* Load up existing artefacts in the new toolkit; branch a new dev stream if necessary

.-Tﬂ.|I
.

H Arl=amt=
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Migrating between versions 2/2 swaRe
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After migration
* Graphical tools automatically show local brokers
 If you wish to manage remote brokers, connect to them (IP/Port/QMgr)
* Remove CM and DB if no longer required

Message Broker Explorer (MBX) considerations
¢ MBX is a new component in V7; updated in V8

* MQ does not support co-existence, therefore only one copy of MQ Explorer on a given
machine

* Both V7 and V8 MBX can manage V7 and V8 brokers

 However, V8 MBX recommended to take advantage of new V8 features (e.qg.
applications)

- SHARE in Atlanta



Maintenance SHARE

« Schedule regular maintenance windows *
* IBM recommends that you are on the latest maintenance level
* Plan exactly what will be applied and when
* A highly available environment ensures that there is no downtime

« WNMB has an option to enable/disable new capability in fixpacks
* New nodes and parsers are disabled by default

mqgsichangebroker MB7BROKER —f 7.0.0.2

- SHARE in Atlanta



Where does the configuration data go? "’?
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» As of Message Broker v7+ all configuration data is stored on the file
system

* No database pre-req
So no extra admin overhead when not using databases for message flow applications
» Default location for the data depends on the platform

* Windows

C:\Documents and Settings\All Users\Application Data\IBM\MQSI
* Unix

Ivar/mqsi

« z/0S
It depends!
« Chosen by the user when customizing a z/OS Broker
« Configured by the ++COMPONENTDIRECTORY++ JCL variable

« This location is generally referred to as the workpath and/or registry

- SHARE in Atlanta
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Configuration Data Directories Explained s )
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<workpath>
/common
lerrors
« Abend/error files are written here — always worth monitoring!
/log
* Internal binary trace files
/profiles
« Additional user profile scripts
/components/<broker name>
Internal configuration data for a given broker
/config/<broker name>/<eg name>
Execution group specific command environment scripts
[reqgistry/<broker name>
Internal configuration data for a given broker
/shared-classes
Non deployed JAR files
/XSL
Non deployed stylesheets used by the XSLT node
3 SH“RE in Atlanta
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Moving the Configuration Data s 3

SHARE
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* On z/OS you can use a different component directory per broker to store each
broker’s configuration data in a different location

* Specify a per broker location for the ++COMPONENTDIRECTORY++ JCL variable
when customizing

* On all platforms you can specify mqgsicreatebroker options to move certain
configuration data

* -w workPath
The directory in which working files for this broker are stored
¢ common/errors
* common/log
* components/<broker name>
« components/shared-classes
* -e sharedWorkPath (Unix / Windows only)
Primarily used for enabling multi-instance broker support

Can also be used to move most broker internal configuration data to another location for
HA purposes

* components/<broker name>
* -e overrides —w setting
* registry/<broker name>
Only 1 file is then stored in the default location pointing at the 2" location ...
SHARE in Atlanta
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Broker Runtime Environment

* Broker requires certain environment variables to run

* On distributed platforms mqsiprofile provides the defaults
* Present in the bin directory of the installation
* Needs to be applied before running any commands
* Unix:
Broker is started in the same environment as mqgsistart is run in

* Windows:
mgsistart kicks off the service definition which creates a new shell and applies the profile

» If you need to set additional variables then create a new profile in the
<workpath>/common/profiles directory

« Any scripts found in the profiles directory are run after the broker profile
* Any edits to mqgsiprofile will be overwritten when a fix pack is applied
* On z/OS the ENVFILE sets up the runtime environment
* Generated during broker customization in the broker’'s home directory
« BIPBPROF member contains the default values
« Edit BIPBPROF and submit BIPGEN to generate the ENVFILE
- BIPBPROF can be used for user settings SH ARE in Atlanta
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Per Execution Group Profiles

« Extend or change the environment for a specific execution group
« Distributed
« Add a script (or scripts) to the appropriate directory
* Windows:
<MQSI_WORKPATH>\config\<my_broker_name>\<my_eg_label>\profiles
e Linux & Unix
<MQSI_WORKPATH>/config/<my_broker_name>/<my_eg_label>/profiles

» Scripts are run after mgsiprofile and any scripts in the common/profiles directory are
run

e 7/0OS

« Customize BIPPROF as normal for all execution group parameters

« Copy and customize BIPEPROF for each appropriate execution group
- Edit BIPGEN adding an additional step for each new BIPEPROF

« Submit BIPGEN

 ENVFILE & ENVFILE.<eg name> generated in broker’'s home directory

.-' ™
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Runtime UserlDs

Windows:
 Runs as the userid of the services definition

* mgsicreate/changebroker —i —a to set/update

« Can also use the LocalSystem account
e Unix

* Runs as the userid who issues the mqsistart command
 z/OS

* Runs as the user defined in the started task definition

* The user requires an OMVS segment with a home directory

* Windows/Unix: The userid that starts the broker no longer requires mgm
authority

* Butitis required to create a broker

* No Database UserlD and Password required from v7
« Use mqgsisetdbparms to control default ODBC and JDBC access control
* Any v6.x defaults are migrated

- SHARE in Atlanta



Runtime Resources UserlDs SHARE

* You can control the credentials used by the broker to connect to external
resources by using mqgsisetdbparms

» Associate credentials, normally username/password with a resource name
* Resource name is referenced from a flow or configurable service definition
* mgsisetdbparms used to create, alter & delete credentials

» Credetials can be set for nearly all external resources which broker can
connect to

« CICS, ODBC/JDBC databases, Email POP/IMAP/SMTP, FTP, IMS, JMS/JNDI,
Kerberos Key Distribution Center (KDC), SFM, keystores, EIS providers, WSRR

» After updating any userid/password definitions you must restart the relevant
execution group/broker to pick up the changes

- SHARE in Atlanta
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Where to look when it all goes wrong!

e Local Error Logs

* Message Broker components use the local error log to record
information about major activities
Actual local error logs vary by platform
* Windows — Windows Event Log (Application View)
* Unix/Linux — syslog
» z/OS — JOBLOG & system console log

e stdout/stderr

» Useful place to look for errors / debugging and always worth checking
for exceptions if problems are occurring

Can be useful for flow developers who use Java and code system.out.printin
statements for debugging

e coredumps / SVC dumps

* In the unlikely event that Message Broker encounters a problem that
results in an abend you need to be aware of where to look for dumps
Check error logs for location or look in the broker’'s home dir
On z/OS check the system dump datasets

.-Tﬂ.|I
.
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Notes: Local Error Logs

« Key information point for an administrator to monitor

» Message Broker components use the local error log to record
information about major activities

» Actual local error logs vary by platform
Windows — Windows Event Log (Application View)
Unix/Linux — syslog
z/OS — JOBLOG & system console log

« When an error occurs, check the local error log first

« Often requested by support
Windows
* The event log fills up so check the size is sufficient or that circular
logging is enabled

Unix/Linux
» Make sure you configure the syslog daemon

- SHARE in Atlanta
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» Useful place to look for errors / debugging
Always worth checking for exceptions if problems are occurring

« Each major component redirects its stdout/stderr streams to files
Windows
« Admin Agent

C:\Documents and Settings\All Users\Application Data\IBM\MQSI\components\<brkName>\console.txt

« Execution group
C:\Documents and Settings\All Users\Application Data\IBM\MQSI\components\<brkName>\<egUUID>\console.txt
Linux/Unix

« Admin Agent

Ivar/mgsi/components/<brkName>/stdout & stderr

« Execution group
Ivar/mqsi/components/<brkName>/<egUUID>/stdout & stderr

z/OS

« STDOUT / STDERR DD cards in the joblog for both the main broker address
space and for any execution groups

* Can be useful for flow developers who use Java and code
system.out.println statements for debugging

. LI
L &
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Notes: Coredump =

o
* In the unlikely event that Message Broker encounters a problem
that results in a coredump you need to be aware of where to look

for dumps

* Windows
BIP2111 error message (message broker internal error).
The error message contains the path to the MiniDump file in your
errors directory

o Linux/UNIX
BIP2060 error message (execution group terminated unexpectedly)
Look in the directory where the broker was started, or in the service
user ID's home directory, to find the core dump file

Check your ulimits
* We recommend an unlimited hard & soft limit for corefile size

« Ensure you have enough disk space

- SHARE in Atlanta
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Notes: SVC dump (z/OS) B
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* Message Broker on z/OS should always produce an SVC dump

* Dump dataset is written based on the system defined setup
Use the “display dump” command to display the naming options

BIP2060 error message (execution group ended unexpectedly) from the main
Broker Address Space.

Message should be accompanied by one of the following messages and dump

» [IEF4501 message in the syslog, or component's joblog, showing an abend code followed
by a reason code, for example:

IEF4501 MQ83BRK DEFAULT - ABEND=S2C1 U0000 REASON=00 0000C4

* Look in the system's dump dataset hlg for the dump dataset, or search the syslog for the
appropriate IEA611l message to find out the dump dataset name.

* In extreme cases you may see a coredump instead
In these cases you will see an IEA993] message in the syslog
Look in the started task user's directory for the coredump.pid file, as specified in
the syslog:
IEA993I SYSMDUMP TAKEN TO coredump.00500319
 If a dump is not produced then look for a reason why in the JOBLOG and
system console log
Check both as errors are not always repeated
A dump might have been suppressed by DAE
. SHARE in Atlant:



Summary SHARE

 We have discussed a number of different ways that help ensure that WMB
administration is trouble-free

« Top Tips
« Always ensure your environment is reproducible
« Treat DR and HA separate
* Ensure regular backups

* Encourage developers to create message flows that enables operational
tweaks to be made

* Schedule regular maintenance windows
* Know where to look when it all goes wrong!

LR
- SHARE in Atlanta



Monday Tuesday Wednesday Thursday Friday
08:00 Free MQ! - MQ Clients MQ Performance and
and what you can do Tuning on distributed
with them.
09:30 The MQ API for The Dark Side of The even darker arts of CICS Programs Using
dummies - the basics Monitoring MQ - SMF SMF WMQ V7 Verbs
115 and 116 record
reading and
interpretation
11:00 Putting the web into Message Broker The Do’s and Don'ts of
WebSphere MQ: A look administration z/OS Queue Manager
at Web 2.0 technologies Performance
The Doctor is in. Hands-
on Lab and Lots of Help
with the MQ Family
12:15 WebSphere MQ: Highly MQ & DB2 — MQ Verbs in
scalable publish DB2 & Q-Replication
subscribe environments
01:30 WebSphere MQ 101: | What's new in The Do’s and Don'ts of Diagnosing problems for
Introduction to the WebSphere Message Message Broker MQ
world's leading Broker V8.0 Performance
messaging provider
03:00 WebSphere What's new in WebSphere MQ Diagnosing problems for
Message Broker WebSphere MQ V7.1 Security - with V7.1 Message Broker
101: The Swiss army updates
knife for application
integration
04:30 Introduction to the Under the hood of MQ Java zero to hero Shared Q including Shared
WebSphere MQ Message Broker on Message Data Sets
Product Family - z/OS - WLM, SMF and
including what's new more
in the family
products
06:00 For your eyes only - MQ Q-Box - Open
WebSphere MQ Microphone to ask the
Advanced Message experts questions
Security
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